
Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

 1. To complete a function, you must include its arguments.

 2. Icon sets display an image in the range based on the value.

 3. The SUM function calculates a text value as 1.

 4. The first character for all functions is a left parenthesis.

 5. The TODAY function does not have arguments.

 6. Custom formats include ? and * to show days and months.

 7. Most statistical functions ignore text in their calculations.

 8. You can copy data from one worksheet to another with the Fill handle.

Short Answer Questions
Write the correct answer in the space provided.

 1. Name the three types of data visualizations.

 2. How can you select more than one worksheet tab?

 3. Name the function that adds cell values only if they meet your criteria.

 4. What function displays the arithmetic mean of a range of cells?

 5. What does Excel do if a function is volatile?

 6. What term is used to describe the information between parentheses in a 
function?
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T    F 
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 7. What feature helps you complete a function after you key � and its first 
character in the cell?

 8. What function would display the highest sales amount in a column?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

 1. What are some math and trig functions that you did not use in this 
lesson? How might they be helpful in school work or on the job?

 2. What type of businesses might use calculations that would use the 
date and time functions? Give examples of how they would use the 
functions.

Skills Review

Exercise 6-22
Use Math & Trig functions. Use Statistical functions.

 1. Open HolidayPay. Save it as [your initials]6-22 in your Lesson 6 folder.

 2.  Click the Select All button . Then click the Bold button . All cells 
are set for bold.

 3. Move the data in cells C13:H16 to start in cell C9.

 4. In cell C15, key Number of Employees.

 5. Use math and trig functions by following these steps:

 a. Click cell H13.

 b. Key �sum( to start the function.

 c. Click cell H6 and drag to select cells H6:H12. Press .

 d. In cell E15, key �counta( to start the function.

 e. Click cell C6 and drag to select cells C6:C12. Press .

 6.  In cell I6, key a formula to multiply the hours worked by the holiday 
rate. Widen the column slightly and copy the formula through row 12.

 7. Use math and trig and statistical functions by following these steps:

 a. Click cell I13. Click the Formulas tab.

 b. Click the Math & Trig button .
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  c. Scroll and click SUM. 

  d.  Check that the range to be summed is I6:I12. Click 
OK.

  e. Widen column I as needed.

  f.  Click cell E16. Click the Insert Function button .

  g.  In the Or select a category list, choose All. Quickly 
key coun and find COUNTIF. Select it and click OK.

  h. For the Range box, select cells I6:I12.

  i.  In the Criteria box, key >250 to count employees 
who earned more than $250. Click OK.

 8. Key Over $250 in cell C16.

 9. Add Top and Double Bottom borders to cells H13:I13.

 10.  Press � . Add a footer and adjust the left and/or right margin to 
fit the sheet to a portrait page.

 11. Make a copy of the worksheet and name it Formulas.

 12. Press  � . AutoFit the columns.

 13.  Click the Page Layout tab. Click the Page Orientation button  and 
choose Landscape.

 14.  In the Scale to Fit group, click the arrow with the Width button 
. Choose 1 page. Use the same choice for Height.

 15. Prepare and submit your work. Save and close the workbook.

Exercise 6-23
Use Math & Trig and Statistical functions. Use an icon set.

 1. Open Insurance. Save it as [your initials]6-23 in your Lesson 6 folder.

 2. Key math and trig and statistical functions by following these steps:

  a. Click cell D17. Key �coun and press .

  b.  Click cell C4 and drag to select cells C4:C14. 
Press .

  c.  In cell D18, key �sum and press . Select cells 
C4:C14 and press .

 3. Use Insert Function by following these steps:

  a. Click the Formulas tab.

  b.  Click cell D19. Click the Insert Function button . 
Choose Statistical and COUNTA. Click OK.

  c. Select cells D4:D14. Click OK.

  d. Click cell D20 and press � .

  e.  In the Or select a category list, choose Most Recently 
Used and COUNTA. Click OK.

  f. Select cells A4:A14. Click OK.

NOTE

If the assumed range is not correct, click 
and drag to select the correct range.

NOTE

The COUNTIF function is similar to the 
SUMIF function, but it is in the Statistical 

category.

REVIEW

For many functions, you need not key the 
entire name for AutoComplete to find it.

NOTE

The Most Recently Used list shows the 
functions you have used during the work 

session.
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 4.  Remove the decimals from the values in column D. Center the labels in 
rows 1:2 across the data. Change the document theme to Paper.

 5. Use icon sets by following these steps:

 a. Select cells E4:E14 and click the Conditional Formatting button .

 b. Choose Icon Sets and Red to Black in the first column.

 c. Select cells E4:E14 and click the Conditional Formatting button .

 d. Choose Manage Rules. Click Edit Rule.

 e. Click the arrow with Percent for the first icon. Choose Number.

 f. Change the Type for the second and third icons to Number.

 g. Click to select Reverse Icon Order.

 h. Key 2000 in the Value box for the first icon (black).

 i. Key 1000 in the Value box for the second icon (gray).

 j. Key 500 in the Value box for the third icon (light red).

 k. Click OK. Click OK again.

 6.  Press � . Add a header and change the left margin to 1.50 inches.

 7. Prepare and submit your work. Save and close the workbook.

Exercise 6-24
Group worksheets. Use Date & Time functions. Use Math & Trig and 
Statistical functions.

 1.  Use the ChkBk template to create a new workbook. 
Save it as [your initials]6-24 in your Lesson 6 folder.

 2. Group worksheets by following these steps:

  a.  Right-click the Sheet1 tab. Choose Move or Copy. 
Select Sheet2 in the Before sheet list. Click to select 
Create a copy. Click OK.

  b. Make another copy and place it before Sheet2.

  c.  Click the Sheet2 tab. Hold down  and click the 
Sheet3 tab.

 d. Right-click either tab and choose Delete.

 e.  Rename the sheets as Week1, Week2, and Week3. Assign an accent 
color to each tab.

 f. Click the Week1 tab. Hold down  and click the Week3 tab.

 3. Use a date function by following these steps:

 a. Click cell A4, key �to, and press . Press � .

 b. Click cell A5 and key � to start a formula.

 c. Click cell A4 and key �5 to add five days to today’s date.

 d. Press � .

REVIEW

Copy the template to the appropriate 
folder for your computer. Then choose 

My Templates in the New Workbook 
dialog box.
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  e. Copy the formula in cell A5 to cells A6:A15.

  f.  Key your name in cell A20 while the sheets are 
grouped.

 4. Ungroup worksheets by following these steps:

  a.  Right-click any sheet tab in the group. Choose 
Ungroup Sheets.

  b. Click the Week1 tab.

 5. Key the data for columns B:D as shown here.

TIP

You can use the Fill handle for the check 
numbers.

    Credit
 Check # Payee Amount Deposit
6 1002 [your first and last name] 1250
 7 1003 Sutter, Howe, & Jones 2500
 8 1004 Holberg Markets 575
 9 1005 [your school name] 435
10 1006 Hacienda Martinez 575
11 1007 Smithfield Stores 435
12 1008 Grocerytown Enterprises 1200

  Figure 6-18

 6. Use math and trig and statistical functions by following these steps:

 a. Click cell D16.

 b. Key �sum and press .

 c. Click cell D5 and drag to select cells D5:D12. Press .

 d. In cell B16, key �count( and ignore Formula AutoComplete.

 e. Click cell B5 and drag to select cells B5:B12. Press .

 f. Press � .

 7.  Group the worksheets and click the Page Layout tab. In the Scale to Fit 
group, click the arrow with the Height button . Choose 
1 page. Use the same choice for the Width.

 8. Prepare and submit your work. Save and close the workbook.

Exercise 6-25
Use Date & Time functions. Format times and dates.

 1.  Create a new workbook and save it as [your initials]6-25 in your Lesson 6 
folder.

 2.  Click the Select All button . Set the font to Calibri 12 point bold.

 3.  In cell A1, key Klassy Kow Ice Cream Shops. In cell A2, key Olympia Shop. 
Choose a larger font size for these labels.

 4.  Key Date in cell A3, Open Time in cell B3, and Close Time in cell C3. 
Center-align these labels. Make all three columns 12.14 (90 pixels) wide.
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 5. Use date functions by following these steps:

 a. In cell A4, key �today( and press .

 b. Click cell A5 and key � to start the formula.

 c. Click cell A4 and key �1 to add one day. Press .

 d. Copy the formula in cell A5 to cells A6:A10.

 6. Format dates by following these steps:

 a. Select cells A4:A10. Press � .

 b. Click the Number tab and choose Date in the Category list.

 c. Choose March 14, 2001 in the Type list. Click OK.

 d. Widen column A to show the dates if necessary.

 7. Key the times as shown in the figure below.

 Open Time Close Time
 4 9 am 10 pm
 5 10 am 11 pm
 6 10 am 12 am
 7 11 am 12 am
 8 11 am 9 pm
 9 11 am 11 pm
10 11 am 11 pm

  Figure 6-19

 8. Format times by following these steps:

 a. Select cells B4:C10. Press � .

 b. Click the Number tab and choose Custom in the Category list.

 c. Choose h:mm in the Type list.

 d. Edit the code in the Type box to show h AM/PM. Click OK.

 9.  Center the labels in rows 1:2 across the data. Make all rows 26.25 
(35 pixels) tall.

 10.  Insert a row at row 1. Insert a column at column A. Select cells A1:E12. 
Press �  and choose a double border as an outline.

 11.  Select cells A1:E3 and change the font color to white. Then apply black 
fill.

 12. Add a header and change the left margin to about 1.75 inches.

13.  Make a copy of the worksheet and change the tab 
name to Formulas. Display the formulas and adjust the 
column widths; columns A and E can be very narrow. 
Change the left margin to .75 inches. Fit the sheet to a 
portrait page.

14.  Prepare and submit your work. Save and close the 
workbook.

NOTE

Times are shown as a fraction of a 24-hour 
day in formula view.
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Exercise 6-26
Use Date functions. Group worksheets.

 1.  Create a new workbook using the CSCalls template. Save the workbook 
as [your initials]6-26.

 2.  Use the TODAY function in cell A3 and format the cell as white so that 
it is not visible. Key a formula in cell A5 that adds one day to cell A3. 
Shrink the data to fit if needed.

 3.  Key a formula in cell A6 that adds one day to the date 
in cell A5. Copy the formula in cell A6 down to row 25.

 4.  Format cells B5:B25 to show the time using the 1:30 PM 
preset format.

 5.  Key the times and representative names as shown. Use 
AutoComplete where appropriate.

Lesson Applications

REVIEW

Set the Zoom size if you prefer to see the 
entire worksheet at once.

 5 9:30 am Anderson

 6 10:25 am Olmstead

 7 12:30 pm Rogers

 8 1:30 pm Devantes

 9 10:45 am LaPluie

10 2:30 pm Anderson

11 11:30 am Anderson

12 8:45 am Olmstead

13 4:30 pm LaPluie

14 10 am Devantes

15 8 am Devantes

16 3:30 pm Rogers

17 9:45 am LaPluie

18 10:15 am Olmstead

19 12 pm Devantes

20 12:15 pm Olmstead

21 11:15 am LaPluie

22 11:45 am Olmstead

23 2:25 pm Devantes

24 9 am Anderson

25 10:25 am Olmstead

  Figure 6-20
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 6.  Select cells A1:D25. Then hold down  and click the Sheet2 tab. Fill all 
across the worksheets.

 7.  Name Sheet2 as Week2. Make the column widths and row heights the 
same as the Week1 sheet.

 8.  On the Week2 sheet, edit the formula in cell A5 to add seven days to the 
function.

 9.  Group the two sheets and open the Page Setup dialog 
box. From this dialog box, add a footer. Then set 
landscape orientation and change the top and bottom 
margins to .5 inch. Delete Sheet3.

10.  Prepare and submit your work. Save and close the 
workbook.

Exercise 6-27
Group worksheets. Use Statistical functions.

 1. Open ShopPart and save it as [your initials]6-27 in your folder.

 2. Group all four sheets.

 3. In cell A22, key Number of Shops. Make it 11-point Calibri bold italic.

 4.  In cell B22, use COUNTIF to count the shops that 
participated in the Tip Calculator promotion. Copy the 
formula to cells C22:D22.

 5.  Center-align the contents in cells B22:D22. Use 
11-point Calibri bold italic.

 6.  Insert a column at column A and make it 3.57 
(30 pixels) wide. Apply a double outline border 
around cells A5:E23.

 7.  From the Page Setup dialog box, add a footer and 
change the page orientation to landscape.

 8.  Prepare and submit your work. Save and close the 
workbook.

Exercise 6-28
Use Math & Trig functions.

 1. Open ORSundaes and save it as [your initials]6-28 in your folder.

 2. In cell H3, use AVERAGE with cells C4:C8 as Number1. Ignore the error.

 3.  Compute the average sales for medium and large sundaes in cells H4 and 
H5. Adjust column F to show the labels, and make column G very narrow.

NOTE

Use the Page Setup dialog box to apply 
settings to grouped sheets.

NOTE

The worksheets should remain grouped 
throughout this exercise.

TIP

Use the Insert Function dialog box to 
build the COUNTIF function.
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 4.  In cell H6, calculate the revenue by summing the appropriate sales and 
multiplying by the related price. Use a similar formula to determine 
revenue for medium and large sundaes.

 5. In cell H13, add the three revenues to find a total.

 6.  Delete row 14. Add a double top border to the data cells to match the 
other price listings.

 7. Format all non-money values as Comma style with no decimal places.

 8.  Apply a double outline border around cells E1:I10. Move this entire 
range so that it starts in row 5.

 9. Add a header.

 10.  Make a copy of the worksheet and change the tab name to 
SundaesFormulas. Display the formulas. Delete columns with no data 
and AutoFit the other columns. Fit the formula sheet to one landscape 
page.

 11. Prepare and submit your work. Save and close the workbook.

Exercise 6-29  Challenge Yourself
Use date arithmetic.

 1.  Open CoPay. Save it as [your initials]6-29 in your folder.

 2.  Insert a column before column D. Key Date Eligible on 
two lines as the label for this column.

 3.  In cell D5, key a formula to determine the date eligible 
for a reduced copay. The formula should add the 
appropriate number of days to the enrollment date to 
determine when the employee is eligible.

 4.  Copy the formula for the other employees. Make 
adjustments as needed.

 5.  Increase the indent once for the department names to 
create space between the dates in column D and the 
labels in column E. Then widen column E to show 
more space between its labels and those in column F.

 6.  Add a footer and fit the worksheet to one portrait page.

1.

NOTE

Many financial and date calculations use 
365.25 as the number of days in a year.

TIP

There are buttons to increase or decrease 
the indent in the Alignment group on the 

Home tab.
REVIEW

Horizontal centering for the page is 
on the Margins tab in the Page Setup 

dialog box.

REVIEW

Press Alt � Enter  to insert a line break 
within a label.
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 7.  Create a formula sheet. Turn off horizontal centering and fit the 
formulas to one landscape page.

 8. Prepare and submit your work. Save and close the workbook.

On Your Own
In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and be 
creative.

Exercise 6-30
Create a new workbook and save it as [your initials]6-30. Key My Age in 
Days and Years as a label. In column A, key the TODAY() function. In the 
cell below the date, key a formula to add 365.25 days to today. Copy this 
formula to reach 10 years from now. Key your birthdate in column F. In 
column B, use the DAYS360 function to calculate your age in days for each 
date in column A. In column C, divide the number of days by 360. Format 
your work attractively. Add a footer. Prepare and submit your work.

Exercise 6-31
In a new workbook, key the first names of 10 people you know in a 
column. In the column to the right, key each person’s eye color. In the next 
column, key each person’s hair color. Add labels and format your work 
with borders and/or fill so that it looks professional. In a row below your 
data, key Number of Persons with Blonde Hair and Blue Eyes. In a cell next to 
or below this label, use COUNTIFS to determine the answer. If there are no 
such persons in your list, change your label to another color combination 
or change some of the colors in your list to test the function. Save the 
workbook as [your initials]6-31. Add a header and prepare and submit your 
work.
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Exercise 6-32
Open HolidayPay. Delete column G and then column H. Move rows so that 
there is no blank space in the middle of the data. Key new labels below row 
12 so that you can show these calculations: average regular rate, average 
rate increase, and average hours worked. Save the worksheet as [your 
initials]6-32. Add a header or footer. Create a formula sheet. Prepare and 
submit your work.
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